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Processing capacity is a measure of how the results of a process meet customer requirements. Strong process capacity indicates that a high output percentage meets the client's requirements, while weak process capacity means the opposite. Poor process capacity is usually due to unacceptably high output variability falling outside the customer's requirements. Learn more about
process capacity tests (discrete) in the measurement phase, module 3.4.1. of black belt training. run a process capacity test (discreet) in Minitab 1. Select Raw Data: 2. Select Quality Tools &gt; State &gt; Capacity Analysis &gt; Binomial: 3. Select OK: Learn more about process capacity tests (discrete) in the measurement phase, Module 3.4.1 black belt training. black
beltdiscreteMinitabprocess capability Process capability analysis is a major concept and a study must study for professionals who are looking forward to having a firm knowledge on Minitab with Statistics. Minitab is a popular tool that allows one to perform various statistical calculations, would be the test of normality, the analysis of process capabilities and so on. Let's talk about
the same thing in this post. What is Process Capability Analysis? Process ability is the ability to produce products or provide services that meet the specifications defined by the customer's needs. For example: a bottle manufacturer requires that the bottle cap require between 10 and 30 torque units to open the bottle cap. Capability analysis shows how well the manufacturing
process meets these specifications and provides insight into how to improve the process and support improvements. Steps to perform process capacity analysis in minitab step 1: Go to the File menu, click Open Project, and then upload the necessary data. Step 2: Go to the Start menu, switch to Quality Tools, and then to Capacity Analysis. Step 3: From the drop-down menu,
select Normal or non-normal analysis based on whether the distribution is normal or non-normalStep 4: Click non-normal (or normal), enter the details needed to perform the capacity analysis, and then click Ok.Once we click ok, Minitab generates the process capacity in a separate window. To learn more about Process Capability Analysis using Minitab, you can explore
Simplilearn's training courses on Minitab with Statistics. Simpliearning offers 100% Minitab online course on Minitab with Stats. Joshua has experience working in the aerospace/aluminum industry &amp; distribution industry. He received his BBA in accounting from Kent State University.The chart above is output from a process capacity analysis. This type of determines how well a
process remains within the specifications. The analysis itself is based on a sample that is taken from a working process. Created by Joshua CrowderWhat is capacity analysis? A capacity analysis is used to tell if a process can produce results to meet customer requirements. The analysis focuses on a single process variable. In the case of In this tutorial, we will look at the size of
the wire gauge. This type of analysis can be compared with an older analysis to assess whether an improvement effort has made the process more able to meet customer requirements. The data used for an analysis should come from a relatively stable process and follow a normal or approximately normal distribution. Sufficient data must be used to ensure accuracy. Examples of
data for this tutorial can be found here. If you don't have Minitab 18, you can find a free trial here. Examples of data provided in the download. Created by Joshua CrowderCompleting an analysis with Minitab 18Sample data sample sample sample sample sample sample provided shows measurements of a thread 4 times every 2 hours during an 8-hour shift for 8 straight days.
There are 8 samples and the sample size is 4. The wire measurement should be 1.50 +/- 0.05 for each customer requirement. To create analysis, go to Statistics &gt; Quality Tools &gt; Capacity Analysis &gt; Normal Distribution. We select normal distribution assuming that our data follows a normal distribution in this example. Select normal distribution from the menu. Created by
Joshua CrowderSet ParametersPlace the cursor in the single-column box, and then highlight C1 and click select. This will add the data we analyze. Then select the subgroup and enter 1. Because upper and lower tolerance limits are known, add them as well. Click the options button to add a title to the chart. Name the title Process Capability Report for Wire Dialest and click OK
in that window and OK in the process capabilities window. Add to the data we analyze. Created by Joshua CrowderProcess output capacity. Created by Joshua CrowderResults The sample's average is very close to the center of our specification range, but shows a slight change towards the upper limit. My result for CP is 0.7. Since this result is less than one, we consider the
process unstable. Cpk is a more invoked variable and will be lower than Cp. Cpk for this process is 0.61 and more than half of what it should be. If Cpk is below 1.33, it is recommended that the process be subject to change. In this situation, we only used 34 samples and it was not certain if the process was reliable. My next step will be to calculate Cp and Cpk with a larger number
of samples and make sure that the measuring tool used for the size to inspect the wire is not to give a false reading. As the process stabilizes, Cp and Cpk will give better readings, as new results are compared to older studies. ReferencesBoyer, K. &amp; Verma, R. (2010). Operations &amp; supply chain management for the 21st century. Mason, OH: South-Western.Related
ArticlesHow to Create a P-Chart in Minitab to Complete a Regression Analysis in Minitab 18How to Create a Pareto Chart in Minitab 18How to Creation an Xbar-R Chart in Minitab An engine manufacturer uses a forging process to make piston rings. Quality engineers want to assess the capacity of the process. They collect 25 subgroups of five piston rings and Diameters. The
specification limits for the diameter of the piston ring are 74.0 mm ± 0.05 mm. Engineers perform a normal capacity analysis to assess the diameters of the piston rings against the specification limits. Open the sample data, PistonRingDiameter.MTW. Choose. In A single column, enter Diameter. In Subgroup Size, enter 5. In Lower Spec, enter 73.95. In higher spec, enter 74.05.
Click Options. In Target (add Cpm to table), enter 74. Click OK in each dialog box. All measurements fall within the specifications. The process is on target, and the measurements are approximately centered within the specification limits. The Cpk, Ppk, and Cpm capability indices are greater than 1.33, which is a generally accepted minimum value for a capable process. Therefore,
engineers conclude that the forging process meets the requirements for piston ring diameters. Within the standard deviation is an estimate of variation within subgroups. If the data is collected correctly, the variation within the subgroup should not be influenced by changes to process inputs, such as tool wear or a lot of materials. In this case, the standard deviation is the natural
and inherent variation of the process in a short period of time. It indicates the potential variation in the process if exchanges and derivatives between subgroups have been eliminated. If you use a data transformation when performing capacity analysis, Minitab also calculates StDev(Within)*, the standard deviation within the subgroup of converted data. Compare the standard
deviation within the subgroup with the global standard deviation. A substantial difference between the standard deviation within the subgroup and the global standard deviation may indicate that the process is not stable or that the process has other sources of variation in addition to the variation within the subgroups. Use a control chart to verify that the process is stable before
performing a capacity analysis. Minitab uses standard deviation within the subgroup to calculate Cp, Cpk and other potential process capacity measures. 福 VIP福免费专专° 权 Pp and Cp Process Capability Indices describe how closely a process can operate within its specifications. Many articles describe the difference between Pp and Cp simply: one is short-term, one is long-
term. Going beyond such a description, this article focuses on the untapped power of capacity analysis and shows you to use Pp and Cp to your advantage. Overview of Pp Versus Cp The difference between Pp and Cp comes from the standard deviation used in the calculation. The global standard deviation is used in the calculation of Pp. This is the standard deviation of all data
combined, regardless of data. Pp= (USL – LSL) / (6*ρoverall) Where σ = standard DEVIATION USL = upper limit of LSL specification = lower limit of specification To calculate Cp, within the standard is used. Cp= (USL – LSL) / (6*ρwithin) Notice about the sample minitab output from Figure 1 that Cp is also known as potential capability. You can get a better understanding of what
the process is telling you and what the process is really capable of with this potential ability. Figure 1: Analysis of sample capacity In Figure 1, the dotted black line represents the normal distribution of data using the global standard deviation of 0.20, while the red line represents the normal distribution of data using the standard deviation of 0.11. Notice that Pp is 0.58 and Ppk is
0.11, while Cp is 1.03 and Cpk is 0.20. Since Pp uses the global standard deviation and Cp uses the standard deviation within the term, the ability has the potential to go from 0.58 to 1.03, Pp to Cp, respectively. Notice also that the defect rate would go from 36.72 percent to 27.34 percent – a potential reduction of 25 percent. What is within the capacity and is calculated? The
answer to this, like many questions on statistics, is, depends. The standard deviation within is a function of the size of the subgroup that is used or chosen when capacity analysis is generated. This leads to the subject of subgroup size. Handlekd Content: Process Capability Calculations with Non-Normal DataSubgroup Size Matters Many training instructors and default materials
to use 1 as subgroup size when teaching capacity analysis. There is nothing wrong with using a subgroup size of 1 (Figure 2); however, it limits what you can learn about within the variation and often overestimates the ability of true potential. Figure 2: The input screen for capability analysis with subgroup size of 1 Standard deviation is based on the difference from one
measurement to another in a data set, similar to a mobile area chart. The standard deviation is estimated from these differences. If, as with a size 1 subgroup, the process has a small variation from sample to sample (inside) and a significant amount of variation over time (generally), you may see a capacity analysis with a high and weak normal curve in the short/short/potential
term. The process capacity shown in Figure 3 uses the same data as the initial capacity analysis, but this time with a subgroup size of 1. Figure 3: Process capacity with subgroup size of 1 Figure 4 displays the same data using a subgroup size of 5. Figure 4: Capability analysis with subgroup size of 5 Global standard deviation and resulting Pp does not change; is not affected by
the size of the subgroup. However, the standard deviation increased from 0.1135 to 0.1561, thus changing the CP from 1.03 to 0.75. Expected performance has increased from a 27.34% to 33.06%, even if nothing has changed in the process. Again, the same data is used in each example. The difference between the standard deviation in which n = 1 versus n = 5 is as follows:
Using a subgroup size of 1 requires two consecutive points calculate the difference and the estimated standard deviation is calculated on the basis of these differences. For this reason, it is important to note that because the standard deviation inside the use of the motion interval, the data must be in production order. Otherwise, the calculation of the standard deviation and the
resulting CP will be incorrect. Handled Content: Finding Sigma level of customer complaintsUsing a subgroup of 5 takes the standard deviation of 5 samples, then the following 5 samples, then the following 5 samples, etc., and estimates within the standard deviation. Should you run the analysis using a subgroup size of 1 or 5? The size of the subgroup used for analysis should
reflect how the data was collected. If you collected 5 measurements every hour, then use a subgroup size of 5. If you have collected individual samples over time, then the subgroup size is 1. Getting more from capacity analysis Consider capacity analysis for a particular variable Y, would be the variation of the product from the target, at different levels of an X variable, would be
SKU (storage unit), instead of using a predetermined subgroup dimension. Resuming capacity analysis using variable X level as a subgroup (shown in Figure 5) will lead to the results shown in Figure 6. These are the same data used in the previous capacity analysis, but these data are sorted by variable X. Figure 5: Analysis of Input Capability Screen with Subgroup Size of SKU
Figure 6: Capacity Analysis with Subgroup Size of SKU Analysis of data with homogeneous rational subgroups instead of using a subgroup size of 1 will help answer the following question: What would be the process capacity if all levels of variable X were more similar , with the same mean and the same standard deviation? In other words, what is the process capacity if the
variation between variable X levels has been removed? Hand-chosen content: Competent use of capacity analysisIn this case, the improvement would go from 0.58 (Pp) to 0.80 (Cp) and would have an overall average of 0.0315 and a standard deviation of 0.146. In conclusion, the capacity within depends on the size of the subgroup. The analysis of the reference analysis and
setting capacity can be particularly useful for comparing the current process with another process, reference point or project objective. What is the potential capacity at a predefined average and standard deviation? This could be in respect of a particular SKU, the product of a competitor, a project objective, etc. Continuing with the same example, suppose that the purpose of the
project is to center the process at -0.25 (centered between specification) and reduce the standard deviation to that of SKU F, 0.0357 (Figure 5). With the historical mean options and historical standard deviation from the Minitab window (Figure 7) completed, the results capacity analysis are shown in Figure 8. Figure 7: Capability Analysis Input Screen Showing Historical Areas
Figure 8: Capability Analysis with Subgroup Size of SKU and Target Data A notable difference is that normal curves for both the inside and overall process no longer represent the data. The red curve represents the historical parameters (average = -0.25, standard deviation = 0.0357) and overrides the standard deviation in the data. The dotted black line is also centered on
historical average (-0.25), but maintains the overall standard deviation from the data. This information can help determine the process could show whether the media would be centered and the variation small – that is, the potential capacity of the process. For the example shown here, if the process has been improved at the levels entered in the historical standard deviation boxes
and historical averages, the process has the potential to move from a capacity of 0.58 to 3.27. This knowledge can be used to justify the project, as the fault rate can be determined when target improvements are applied for both the centre and the variation. Capacity analysis is an extremely powerful analytical tool and can be used for many applications. It is important to
understand the standard deviation and to know how a reference capacity analysis can be used to determine a future state of the process. Process.
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